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Introduction
This document describes the LANDIS-II-Site tool for use with the
LANDIS-II model. For information about the model and its core
concepts, see the LANDIS-II Conceptual Model Description.

1.1 Installation
LANDIS-II-Site does not require formal installation; it can be run
directly using the executable file (LANDIS-II-Site_V2.4.exe).
However, the program requires all of the .dll and .netmodule files from
the Zip to be located in the same folder as the executable file when it
is run.

1.2 Major Releases
1.2.1 Version 2.4
Version 2.4 includes a bug fix related to the calculation of
“development mortality”. This version includes the equation as
applied in v3.2 of Biomass Succession:
M BIOij = ANPPMAXi ×

2 × B APij
(1 + B APij )

× BPMij

This version also includes a bug fix related to the calculation of initial
cohort biomass. This version includes the equation as applied in v3.2
of Biomass Succession:

InitialBiomass = ANPPMAXi × Exp(− 1.6 × BSUM / BMAX − ECOREGION )
Version 2.4 has also dropped the option of Succession Method v3.5,
which was for developmental testing purposes only.
This version includes the option to record and/or manually set the
random number seed (see 2.11.4).
1.2.2 Version 2.3
Version 2.3 includes a name change for this utility tool. The previous
name of SiteVegetationCalculator has been replaced by LANDIS-IISite. The version numbers have continued to maintain the full lineage
of this tool. In this User Guide, the tool is sometimes referred to as the
Calculator.
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Version 2.3 increases the number of possible species to 6. Also,
additional control over cohort removals has been added so that
removals can impact only the oldest cohort, or all cohorts equally.
1.2.3 Version 2.2
Version 2.2 adds the function of vegetative reproduction for each of
the species. This functionality requires 3 additional species
parameters (vegetative reproduction probability, minimum resprout
age, and maximum resprout age). The change in parameters means
saved species files from previous versions will not work. To modify
old saved files to work with the new version, add the 3 lines of text
representing the new parameters between the lines representing
Woody Decay Rate and ANPP Max.
Version 2.2 also includes a bug fix that caused erroneous behavior
when a timestep of 1 year was selected.
1.2.4 Version 2.1
Version 2.1 provides the final version of Biomass V3.5 along with
Biomass V3.0 and Age Class Succession. A “Range” option has been
added so that for certain parameters, multiple values can be run and
graphed together. The ability to remove a cohort (partially of fully) at
a given time has been added. Users can simulate up to 4 species
starting with this version. Additional options for output have been
added, and species parameters can now be saved and loaded from text
files.
1.2.5 Version 2.0
Version 2.0 includes the final versions of Biomass V2 (2.1) and an
early version of Biomass-LAI, as well as a Competition Comparison
method that allows users to compare different forms of competition.
The input parameters have been reorganized, parameters no longer
used have been removed, and a new planting option has been added to
allow the user to “plant” a cohort at any time in the simulation.
1.2.6 Version 1.1
This version expands the capabilities of version 1.0 to simulate up to 3
species, expands the graphic and log output, offers different
succession methods, and other options to expand the utility of the tool.
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1.2.7 Version 1.0
The original version of this tool is Version 1.0. Revisions and
enhancements of this tool will be denoted by increasing version
numbers.

1.3 Minor Releases
1.3.1 Version 2.4.2
This version fixes a bug in the growth calculations that resulted in too
high competition among cohorts. This bug in the site tool caused
results to be different from Biomass Succession v3.2.2.
1.3.2 Version 2.4.1
This version fixes a bug in the calculation of initial biomass when
using a 1-year timestep and multiple cohorts establish in the same
timestep. This was Issue #4 in Biomass Succession, which was
resolved at Version 3.2.2.
1.3.3 Version 2.3.1
This version fixes 2 minor bugs in the interface. The first bug fix is
the disabling of the input text box MaturityAge for Species 6 when
Biomass Succession is selected. The second bug fix is to allow
decimal values to be entered for leaf longevity, which were previously
restricted to integer values.

1.4 References
LANDIS-II Documentation Online:
http://www.landis-ii.org/documentation.
LANDIS-II Age-Only Succession v3.0 Extension User Guide:
http://www.landis-ii.org/extensions/age-only-succession
LANDIS-II Biomass Succession v3.2 Extension User Guide:
http://www.landis-ii.org/extensions/biomass-succession

1.5 Acknowledgments
Valuable contributions to the development of this tool were made by
Robert M. Scheller and Michael J. Papaik.
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2 Tool Description
2.1 Overview
The LANDIS-II-Site tool is designed to simulate succession on a
single site using the same shade and succession algorithms that are
used in LANDIS-II. The simulation runs for a defined number of
years with the option of having additional cohorts establishing based
on defined establishment probabilities and shade class rules. Users
can define whether a species is present at the beginning of the run, at
what time seeds become available for each species, and at what time
cohorts are planted. LANDIS-II-Site is can simulate up to 6 species
and can simulate Age-Only Succession, Biomass Succession v3.2.
The program automatically graphs species biomass, percent shade,
shade class, number of cohorts, cohort ANPP, cohort biomass, and
dead woody biomass by species. Some outputs are not generated
with Age-Only Succession. Multiple simulations can be run and
graphed together, with each simulation represented by a randomly
selected unique color (except in batch mode). An optional log file
can also be created for each simulation run recording some of the
same data as the graphs.

2.2 Assumptions
LANDIS-II-Site uses several important simplifying assumptions:
•

•
•
•

Dispersal distance from outside seed sources is not considered;
seeds can always reach the simulated site once the Seed
Availability Year has been reached.
Succession and shade rules for the succession method
determine growth, death, and additional establishment.
The site experiences no disturbances for the duration of the
simulation.
Planting a cohort at a specified year does not follow the shade
establishment rules. When a cohort is planted, it will always
establish.
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2.3 Simulation Parameters
2.3.1 Number of Species to Simulate
The user can choose to simulate up to 6 species at a time. The
program identifies which species to simulate based on the Spp
Numbers listed under the Species Parameters. For example, if the user
chooses to simulate 2 species, the model will use the species labeled
with Spp Numbers 1 and 2, regardless of their order in the table.
2.3.2 Simulation Years
The Simulation Years defines the length of time the simulations
should be run.
2.3.3 Timestep
The Timestep defines the time interval between attempts to establish.
Succession runs growth calculations at an annual timestep, but
establishment years are controlled by the input Timestep.
2.3.4 Removal
Users can choose between 2 options for how removals are applied.
“Oldest Cohort” will cause removals to only impact the oldest cohort
of a species. For example, a 0.5 removal using “Oldest Cohort” will
remove 50% of the oldest cohort’s biomass. “All Cohorts” will cause
removals to equally impact all cohorts of the species. For example, a
0.5 removal using “All Cohorts” will remove 50% of each cohort’s
biomass.

2.4 Succession Method
2.4.1 Age-only
This method uses succession functions that are used in the released
Age-only Succession V3.0.
2.4.2 Biomass V3.2
This method uses the growth and mortality functions that are used in
the released Biomass Succession V3.2.
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2.5 Output Options
2.5.1 Output Log
The Calculator will produce an output log for each run if the user
checks the box labeled “Output Log” or by selecting “Output Log”
from the “Options” menu. See section 3.2 for details of the Output
Log.
2.5.2 Graph Legend
The Calculator will provide a legend for each graph, identifying the
run number for each graphed line, if the user keeps the box labeled
“Graph Legend” checked. The legends can be turned off by
unchecking the box or deselecting “Graph Legend” in the “Options”
menu. It is recommended that the legends be turned off when running
many replicate runs (especially Batch Mode), because the legend takes
space away from the graphs as it grows in size.
2.5.3 Batch Mode
A batch mode that runs multiple replicates using the same input values
can be turned on by selecting “Batch Mode” in the “Options” menu or
by checking the box labeled “Batch”. When Batch Mode is selected, a
box appears in the Output Options box where the user can specify how
many replicates to run. All of the replicates will be graphed as they
run, and will create output logs for each replicate if Output Log is
checked. It is highly recommended that users turn off the Graph
Legends when using Batch Mode. Graphed lines in Batch Mode
appear as semi-transparent black (species 1), blue (species 2), red
(species 3), magenta (species 4), green (species 5) or cyan (species 6)
lines which darken in places where multiple replicates coincide.
2.5.4 Range Mode
When Batch Mode is selected, the option of using Range Mode
becomes available. Range Mode allows multiple values of certain
variables to be run sequentially and graphed together within 1 run of
the calculator. Range Mode can be turned on by checking the box
labeled Range. When Range Mode is selected, a single check box
appears next to the parameters ANPP Max, Mortality Shape, Growth
Shape, Prop Mort, and Age Mort. Only one parameter can be selected
for range mode on each run. Choose a range parameter by checking
one of those boxes. Range mode will run multiple replicates for each
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parameter value as it does in batch mode, so you may wish to set the
number of replicates as well.
When you click RUN while in Range Mode, a popup box will appear
asking for the values of the range parameter. Users should enter a
lower value (defaults to value in the main form), an upper value, and
an increment between the two. For example, if the values entered
were 2 for lower value, 5 for upper value, and 0.5 for increment, the
model would run simulations with the parameter set to 2, 2.5, 3,
3.5,…,5.
The output in Range Mode appears in the graphs with a predefined
color scheme. The output from the lowest parameter value appears as
green, the output from the highest parameter value appears as red, and
output from parameter values in between are represented by a mixed
color scaled proportionately between green and red colors. The output
in Range Mode also used the same semi-transparent display scheme as
Batch Mode, so that areas that overlap multiple times are darker. As
with Batch Mode, it is recommended that the Graph Legend option be
turned off when using Range Mode, as the legend can become large
reduce the size of the output graphs.
2.5.5 Add Reference
Reference values can be added as points to any output graph. Clicking
the ‘Add Reference’ button opens a new form that allows users to
choose a text file with the reference data, and the output graphs to
which those reference points should be added. The reference text file
should be a space delimited text file, with column headings. The first
column should represent the age or year and have a heading of ‘Age’,
and the second column should represent the output values. The second
column should also have a heading, but it does not have to be named
anything specific.
2.5.6 Output Folder
When Output Log is selected, you can direct the output logs to be
written to a specific folder. If no output folder is specified, the logs
will be written to the location that contains the LANDIS-II-Site
executable file.

2.6 Species Parameters
Species parameters are attributes that apply to all cohorts of a species,
across all ecoregions (in a LANDIS-II simulation). These attributes
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are equivalent to those found in the LANDIS-II species attribute file
and the succession parameter file (SpeciesParameters Table).
2.6.1 Spp Number
The Spp Number identifies which species will be simulated if the
Number of Species to Simulate is less than 4. The Spp Numbers also
correspond to the numbering of species in the graph legends.
2.6.2 Longevity
Maximum age the species can reach.
2.6.3 Shade Tolerance
Shade tolerance class (1-5).
2.6.4 Maturity Age (Age-Only)
Age of sexual maturity.
2.6.5 Leaf Longevity (Biomass only)
Number of years that leaves remain on a tree. This is used to
differentiate woody biomass from leaf biomass. For deciduous species
this value should be 1.
2.6.6 Woody Decay Rate (Biomass only)
The rate of decay (proportion/year) that woody biomass decays.
2.6.7 Vegetative Reproduction Probability
The probability that a cohort killed by disturbance reproduces
vegetatively (resprout). Establishment of a resprouted cohort is not
subject to the species establishment probability. Vegetative
reproduction is subject to shading rules (light availability).
2.6.8 Minimum Resprout Age
The minimum age at which a cohort can reproduce vegetatively.
2.6.9 Maximum Resprout Age
The maximum age at which a cohort can reproduce vegetatively.

2.7 Species/Ecoregion Parameters
Ecoregion-dependent species parameters are attributes that apply to a
specific combination of species and ecoregion. When simulating
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dynamics on different ecoregions, these parameter values can vary.
These attributes are equivalent to those found in the LANDIS-II
succession Dynamic Input file.
2.7.1 ANPP Max (Biomass only)
The maximum ANPP for the species on the specific ecoregion. A
lower productivity site would have a lower maximum ANPP value.
2.7.2 Biomass Maximum (Biomass only)
The maximum biomass that the species can reach on the specific
ecoregion. A lower productivity site would have a lower maximum
biomass value.
2.7.3 Mortality Shape parameter (Biomass only)
The Mortality Shape Parameter controls the timing and intensity of
age-related mortality. The parameter determines when age-related
mortality begins and can prevent the cohort from reaching its potential
maximum biomass.
2.7.4 Growth Shape parameter (Biomass only)
Parameter that determines the steepness of the ANPP curve.

2.8 Species Establishment Rules
2.8.1 Establishment Probability
The species establishment probability determines the probability of
establishment of a new cohort during each timestep. Where the
establishment probability is greater than 0, a cohort will establish if
both shade conditions allow AND a uniform random number (0-1) is
less than or equal to the establishment probability.
User Tip: Simulations using this tool are deterministic if
establishment probabilities are either 0 or 1, but are stochastic for any
values between 0 and 1. Probabilities of 0 show the growth and death
of a single cohort through time. A species that is not present at the
start of the simulation will never appear if it has an establishment
probability of 0, unless planted (see below). Probabilities of 1 show
the growth and continual establishment of additional cohorts, as long
as the shade conditions allow establishment.
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2.8.2 Seed Availability Year
Users can make seed unavailable for all or part of the simulation time
for each species. New cohorts cannot establish by seeding (resprout is
still possible) for any year which is less than the Seed Avail. Year for
a given species.
2.8.3 Planting Year
A cohort can be forced to establish at a given timestep regardless of
shade or establishment probability (see note below). If a planting year
is provided that falls between 0 and the end simulation year and falls
during a timestep (multiple of Timestep) then a single cohort of that
species will be established at that time. The establishment of a cohort
by planting will replace a cohort that otherwise would have established
by other means rather than result in two cohorts being added. The
default values for this parameter are 0, to have any simulated species
establish at year 0. Any negative value for Planting Year means that
no planting of the species occurs.
Note: The establishment rule for planting within LANDIS-II-Site
varies slightly from how it works in LANDIS. In the Calculator,
planting can be successful even if the establishment probability is 0.
In LANDIS, establishment probability must be > 0 for planting to be
successful. This difference is intentional in order to maximize the
control of cohort establishment within the Calculator.
2.8.4 Removal Year
Users can force a cohort to be removed prior to its longevity by
specifying a removal year. Removals only impact the oldest cohort of
a given species in the year specified. The removal can completely
remove (kill) the cohort, or remove a portion of its biomass. A
negative value for Removal Year means that no removal of the species
occurs.
2.8.5 Removal Prop
A removal can remove any proportion of a cohort’s biomass, from 0 to
1. A complete removal of biomass (1) kills the cohort (and triggers
potential vegetative reproduction). Removal of less than all of the
biomass allows the cohort to remain living and sets its biomass to
some proportion of what it was. The removed biomass is assumed to
remain on site and goes into the dead biomass pool. When using Age-
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only Succession, if Removal Prop is greater than 0, the entire oldest
cohort is removed.

2.9 Sufficient Light Table (Biomass only)
These modifiers are used to influence the establishment probability
based on the shade tolerance and actual shade class. When the
modifier is less than 1.0, the probability of establishment is multiplied
by the modifier before testing for establishment.

2.10 Shade Class Thresholds
The shade class thresholds define the rules that are used to categorize
the shade class of a site. The parameters and methods are different for
Age-only and Biomass Succession.
2.10.1 Age-only Succession
The shade class is determined by the shade tolerance of the species
present on the site, with only cohort above the age of maturity
contributing to shade. The Shade Class Thresholds are not used with
Age-only Succession.
2.10.2 Biomass Succession
Shade class is determined based on biomass relative to the maximum
site biomass. The parameters represent the minimum relative biomass
(%) required for a site to be each shade class. For example, the default
value for shade class 1 is 15. Therefore, if the biomass of a site is less
than 15% of the maximum biomass, it would be assigned shade class
0. If the biomass is greater than 15%, but below the threshold for
shade class 2 (default 30), then it would be assigned shade class 1.
The default parameters define that only species with shade tolerance 5
can establish if the site shade class is equal to the shade tolerance
class. All other species can only establish if site shade class is less
than the species shade tolerance.
The Landscape Biomass Maximum specifies the maximum species
biomass across all species in the ecoregion. If all species are
simulated, this parameter is not necessary. However, it provides a
method for accurately tracking shade even if the species with the
highest biomass is not simulated in a given calculator run.
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2.11 Control Buttons
2.11.1 RUN
The RUN button runs simulation(s) with the currently selected options
and input values.
2.11.2 Quit
The Quit button exits LANDIS-II-Site and closes the program.
2.11.3 Clear Graphs
The Clear Graphs button clears all existing lines from all graphs, and
resets the simulation counter to 0.
2.11.4 Random Number Seed
The tool will automatically record in the text box the random number
seed that was applied during the last execution of the tool. To control
the random number seed, check the Random Number Seed check box.
Whenever the checkbox is checked, the tool will use the number
provided in the text box as the random number seed. Multiple runs
with the same random number seed will have identical results even
when stochastic processes are running (e.g., establishment
probabilities). Users can synchronize simulations across multiple
computers by using the same random number seeds.

2.12 Saving and Loading Species Parameters
Species and Species/Ecoregion parameters can be saved to a text file
and loaded from saved text files. Under the File menu option are
options for Save Parameters and Load Parameters. The Species
Establishment Rules and the Shrub options are not saved with the
species parameters.
2.12.1 Save Parameters
In the Save Parameters menu option are separate options to save
Species 1, 2, 3, 4, 5 or 6. The Species number corresponds to Spp
Number in the calculator interface. When a species is selected for
saving, a menu will appear to either enter a filename (with full path) or
browse to a location and filename. Files should be saved in a standard
text file format (.txt).

- 14 -

LANDIS-II-Site v2.4 – User Guide

LANDIS-II Tool

2.12.2 Load Parameters
In the Load Parameters menu option are separate options to load
Species 1, 2, 3, 4, 5 or 6. The Species number corresponds to Spp
Number in the calculator interface. The values in the interface for the
chosen species number will be overwritten with the loaded values.
When a species number is selected for loading, a menu will appear to
enter a filename (with full path) or browse to a location and filename.
Files being loaded should be in a standard text file format (.txt).

- 15 -

LANDIS-II-Site v2.4 – User Guide

LANDIS-II Tool

3 Output
3.1 Output Graphs
The simulation output is automatically displayed on 7 graph tabs on
the bottom portion of the tool. The different graphs can be viewed by
clicking on the tabs with the output names. Each time the simulator is
run, a new line(s) (up to 6) will be added to each graph with a new
randomly selected color. The legend tracks the order in which the
simulations were run. Multiple species will be represented by the
same color for each run, but use different line symbols (solid thick for
species 1, solid thin for species 2, thin dotted for species 3, thick
dotted for species 4, thin dashed for species 5, thick dashed for
species 6). All graphs can be cleared by clicking the ‘Clear Graphs’
button. The simulation numbers in the legend (and the numbering of
log files) start over at 1 after the graphs are cleared.
For any graph that is created, users can identify actual values on the
graph by right-clicking on the graph and selecting Show Point
Values. Graphs can also be saved, copied, or printed by using the
context menu that appears when right-clicking on a graph.
Users can zoom in on a portion of a graph by clicking and dragging
the crosshairs on the graph to define the area in which to zoom.
Zooming can be undone using the context menu that appears when
right-clicking on a graph.
3.1.1 Biomass (Biomass only)
Aboveground biomass (kg/ha) for each species. Any single species is
denoted by a solid line. If multiple species are simulated, Species 1 is
denoted by a thick solid line, Species 2 is denoted by a solid thin line,
Species 3 is denoted by a thin dotted line, Species 4 is denoted by a
thick dotted line, Species 5 is denoted by a thin dashed line, and
Species 6 is denoted by a thick dashed line.
3.1.2 Percent Shade (Biomass only)
Relative shade for the site. Shade contributions all species are
combined to calculate site percent shade.
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3.1.3 Shade Class
The resulting shade class (0-5) calculated by the chosen succession
method. Shade class influences establishment according to the
appropriate succession rules and inputs.
3.1.4 Number of Cohorts
Number of cohorts for each species. Count of 10-year age cohorts for
each simulated species. Any single species is denoted by a solid line.
If multiple species are simulated, Species 1 is denoted by a thick solid
line, Species 2 is denoted by a solid thin line, Species 3 is denoted by
a thin dotted line, Species 4 is denoted by a thick dotted line, Species
5 is denoted by a thin dashed line, and Species 6 is denoted by a thick
dashed line.
3.1.5 Cohort ANPP (Biomass only)
ANPP for each cohort. If multiple species are simulated, Species 1 is
denoted by a thick solid line, Species 2 is denoted by a solid thin line,
Species 3 is denoted by a thin dotted line, Species 4 is denoted by a
thick dotted line, Species 5 is denoted by a thin dashed line, and
Species 6 is denoted by a thick dashed line. Multiple cohorts of the
same species appear as multiple lines with the same representation
3.1.6 Cohort Biomass (Biomass only)
Total biomass for each cohort. If multiple species are simulated,
Species 1 is denoted by a thick solid line, Species 2 is denoted by a
solid thin line, Species 3 is denoted by a thin dotted line, Species 4 is
denoted by a thick dotted line, Species 5 is denoted by a thin dashed
line, and Species 6 is denoted by a thick dashed line. Multiple cohorts
of the same species appear as multiple lines with the same
representation
3.1.7 Dead Wood (Biomass only)
Total dead woody biomass for the site.

3.2 Output Log
The simulation output that is graphed is also automatically saved in a
text log file. The log file can be written to a specific folder using the
Output Folder option, or the file(s) is saved to the location from which
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the LANDIS-II-Site program was run. The log file is in commadelimited format (.csv) and is names “Out#.csv”, where # represents
the run number. Each time the simulator is run, a new log file will be
created. Note that clearing the graphs resets the counting of runs, and
therefore subsequent log files will overwrite previous log files.
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4 Input Values
The input parameters for this tool are specified within the textboxes of
the tool. Users must manually type the parameter values into the
boxes in the user interface. Default values represent realistic sample
values for a landscape in Labrador, Canada, and are meant primarily to
demonstrate an appropriate input format. See the Users Guides for the
different Succession versions for details regarding input values.
Generally, the input values come from 2 standard input files for
LANDIS-II: the species input file, and the succession input file.
Input values can be reset to their default values by closing and
reopening the program. There is no way to save a set of parameter
values to reuse.

4.1 Species Number
The “Spp Number” inputs must be 1, 2, 3, 4, 5 and 6 in any order. In
all output, the species identified with Spp Number 1 will always be
identified as Species 1. If the Number of Species to Simulate is
greater than 1, then the species are included in the order of Spp
Number. For example, if 2 species are chosen to simulate, the species
used will be those with Spp Number 1 and 2, no matter what their
order in the input.
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